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ALMA is a partnership of ESO (representing its member states), NSF (USA) and NINS (Japan), together with NRC
(Canada), NSTC and ASIAA (Taiwan), and KASI (Republic of Korea), in cooperation with the Republic of Chile.
The Joint ALMA Observatory is operated by ESO, AUI/NRAO and NAOJ.
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1 What’s new in Cycle 127

The most important changes to the ALMA Observing Tool (OT) since the last release are the following.

e New capabilities:

— Full-polarization single-field interferometry in Band 1 on the 7-m Array (Stand-alone ACA) with the
same polarization capability and accuracy as in Band 3 - 7.

e Band-to-Band (B2B) is allowed in Large Programs starting from Cycle 12. The OT will allow the submission
of a Large Program if any science target requires B2B observing.

e The shadowing tables used by the OT have been updated. For multi-configuration Science Goals, shadowing
is applied also to secondary configurations (TM2, 7M) and their time estimates are corrected according to
their corresponding shadowing factors.

2 Scope

This document is intended as a concise guide to Phase 1 proposal preparation in Cycle 12 for novice and expe-
rienced ALMA users alike. While novice users should carefully follow the step-by-step instructions, experienced
users may want to concentrate on the boxed texts. These highlight new features, useful tips and tricks, and
issues to be aware of, and can be identified by the corresponding icons.

A more comprehensive description of the OT and the different aspects of proposal preparation can be found
in the ALMA OT User Manual. The ALMA OT Reference Manual provides a more concise explanation for all
the fields and menu items in the OT, and can be accessed interactively from within the OT by clicking on the
*?” icons. The User Manual and Reference Manual can also be accessed and interactively searched
via the Help menu in the OT. The OT also contains helpful tooltips that appear when you mouse-over text
boxes or radio buttons.

Unfortunately, the screenshots have not been updated since Cycle 5, but the OT’s appearance has not greatly
changed since then.

3 Getting Started

In order to access the ALMA Archive and submit an observing proposal, you must have previously registered
with the ALMA Science Portal. You can then download the OT from the OT page in the ALMA Science
Portal. Please follow the detailed installation instructions there; in case of any problems you can consult the
Troubleshooting page. After downloading and starting the OT, an initial dialogue box with different options
will appear. To follow the step-by-step guide for creating a new proposal please select the first option, Create a
new proposal.

You will be allowed to change the OT heap space from its default of 4 GB. More memory might be necessary
for complicated proposals requiring many Science Goals or containing many sources, or for large programs.

It is possible to re-use a proposal from a previous cycle as a template for your new proposal using the File
> Open Project as New Proposal feature. Regardless of its status (e.g. it might have been accepted and had
Scheduling Blocks (SBs) generated) it will be retrieved from the ALMA archive and open in the OT as a new
Phase 1 proposal without a project code. Any Phase 2 materials (e.g. SBs) will have been removed. Note that
time estimates, allowed configurations etc. may have changed from previous cycles. This feature also allows
conversion between normal and DDT proposals.

Alternatively, once the OT has opened you can select the green New Proposal (Phase 1) button from the toolbar
in the OT. You will be presented with the window shown in Fig. 1, which illustrates the main Graphical User
Interface (GUI) components:


http://almascience.org/documents-and-tools/cycle12/alma-ot-usermanual
http://almascience.org/documents-and-tools/cycle12/alma-ot-refmanual
http://almascience.org
http://almascience.org/proposing/observing-tool
http://almascience.org/proposing/observing-tool/troubleshooting
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Figure 1: OT Graphical User Interface.

Menu: Allows access to all functions available in the OT via pop-up submenus.
Toolbar: A selection of icons for some of the most frequently used functions in the Menu.

Project Structure Pane: Visualisation and navigation of the Project Tree. Each part of the tree is
known as a “node” and many of these can be expanded or collapsed by clicking (“turning”) the handle icons.
A convenient shortcut for expansion of all nodes below a given node is to click there and then type Ctrl-
or Cmd-Z.

Editor Pane: The technical specifications of the project are filled and edited in this pane. The content
of the editor pane changes depending on the branch of the Project Tree selected. For spatial and spectral
setup, the editor pane is composed of several panels.

Feedback Pane: Provides feedback on the validation process and allows you to identify problems with
your proposal.

Overview Pane: Informative summary of the proposal creation process and contextual help.

You can customize the GUI according to your needs. The size of the different panes can be
modified by clicking and dragging their borders, or maximised/minimised by clicking on the
triangular arrow symbols. You can toggle the Overview and Feedback panes by clicking on View
> Feedback/Overview in the Menu, e.g. in order to maximise the Editor pane. The Feedback
pane will normally not be visible upon starting the OT, but it will pop up when the project is
validated (see Section 12). You can customise the OT further by selecting File > Preferences.
In particular, you may want to change the font size or colour scheme, or preferentially show
certain editors.




s | The OT GUI can be made more modern by selecting a 'flat’ look and feel. You can customise
l the look and feel by selecting File > Preferences > Appearance > Look and Feel. This also
v ) appears to speed up the GUI’s response times.

4 General Proposal Information

Start by filling the fields in the Proposal editor labelled Proposal Title and Abstract, select the Proposal
Type and Scientific Category using the radio buttons and choose up to two Keywords from a list (to select
multiple keywords hold the Ctrl button or the Cmd button on Macs).

Special Proposal Types

Target of Opportunity (ToO) proposals are designed for observations that can be anticipated, but
for which the source coordinates and the timing are not known at proposal submission time. Examples
of typical ToO targets are supernovae, gamma ray bursts or transients. A proposal that simply has time
constraints is not a ToO but should instead be submitted as a Regular proposal, with the requested time
constraints specified in the Control And Performance editor (see Section 10).

Large Programs are proposals that require more than 50 hours of 12-m Array time, or more than 150
hours of 7-m array time requested as part of stand-alone Atacama Compact Array (ACA, also known as
the Morita Array) Science Goals. For these programs, Co-PIs may be specified and the observing time
required will be split between the PI and Co-PIs’ Executives (Europe, North America, East Asia or Chile).

VLBI proposals use ALMA in conjunction with VLBI telescopes around the world. They have a special
VLBI proposal interface at the Science Goal level and the spectral setup is limited to pre-defined continuum
and spectral-line observing setups in Bands 1, 3, 6, and 7. Unlike standard proposals, VLBI observations
require a time estimate (including overheads, which make up ~50 per cent of the expected time on source)
rather than a sensitivity to be entered. Note that ALMA VLBI programs must also have been submitted
to the appropriate VLBI network by their independent deadline.

Phased Array proposals request that the 12-m Array be used as a single dish i.e. using the same phasing
hardware that produces the signal used for VLBI, but without correlating this with the signals from other
telescopes — it is an ALMA-only mode. Phased array observations are possible in Bands 1, 3, 6, and 7.

Joint Proposals with other facilities, including JWST, VLA, and VLT. Joint Proposals are dedicated
to scientific projects that require observations with two or more observatories to achieve their scientific
goals. A Joint Proposal is submitted to a single observatory, called the main observatory, for scientific
peer review, which allows one observatory to award observing time on multiple telescopes. The main
observatory is defined as the observatory requesting the most observing time. In the case of ALMA, this
is the amount of time on the 12-m Array, or the 7-m Array for ACA-only projects. Proposals with ALMA
as the main and as a partner observatory can be created with the OT; the first can be submitted only
during the Call for Proposals, while the latter at any time of the year. VLBI observations, Phased Array
proposals and Large Programs are not allowed for Joint Proposals when ALMA is a partner observatory.

@ Full-polarization single-field interferometry in Band 1 on the 7-m Array is now allowed.

In order for you to be able to submit the proposal, you will have to select yourself as PI by scrolling down,
pressing the Select PI button and searching by name, email or ALMA ID in the pop-up window (see Fig. 2).
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Figure 2: Selecting the PI and Co-Is in the Proposal editor using the User Registry search interface.

The ALMA ID is your Science Portal login.

You can select an unlimited number of Co-Is in a similar way, provided that they have previously
registered with the ALMA Science Portal. Please make sure they do so at least 24 hours prior to the
submission deadline. If you have a long list of Co-Is you may prefer to add them from a proposal previously
saved on disk using the Add from proposal button. Proposal review for proposals that are neither Larg Programs
ot ToOs, will be done using distributed peer review i.e. the reviewing will be done by the PIs submitting such
proposals. Unless Large Program is selected, the OT will require that one of the investigators be selected as a
proposal reviewer. If this person is the PI and does not have a PhD, a mentor can be named who would assist
the PI with the reviewing.

You are not required to indicate if your proposal constitutes a re-submission. This will be determined by
the observatory (please refer to the Proposer’s Guide for details). However, you should justify any duplicate
observations of archival data or previously accepted programs.

The Science Case used for the the scientific assessment of your proposal needs to be attached as a PDF
file not exceeding 4 pages in total (7 pages for Large Programs, see more information later),
including any figures and tables. The science case should put the proposed observations in a broad scientific
context, highlight their impact on the field of research and present the immediate goal you expect to achieve.
With the move to dual anonymous proposal review, all PDFs should be written in a neutral style such that it
is not possible for the reader to determine the identity of the author. More information can be found in the
Proposer’s Guide. While the text of the technical justification is entered directly into the OT (see Section 11),
any associated figures must still be included in the PDF. For more details please refer to the Proposer’s Guide.

For Large Programs, a Management Plan is requested and should be part of the Science Case and Man-
agement Plan PDF. Large Programs must also include a Team Expertise document as a separate PDF, with a
maximum of one page. Under "Scheduling Feasibility" PIs of Large Programs are also requested to use a check
box to confirm that their proposals are consistent with the configuration/LST scheduling constraints for Large
Programs as described in the Proposer’s Guide.


http://almascience.org/proposing/proposers-guide
http://almascience.org/proposing/proposers-guide
http://almascience.org/proposing/proposers-guide
http://almascience.org/proposing/proposers-guide

The fonts used in the PDFs must have a minimum size of 12 points. The OT will issue an
error if >15 per cent of the text is smaller than 12 points. Be aware that an image cropped
from another PDF may contain text that lay outside of the cropped area, even though this is
not displayed.
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Figure 3: Adding the source information in the Field Setup editor.

5 Science Goals

All the technical specifications for your project are contained in one or more Science Goals, each of which
contains six nodes covering different aspects of the observations. Each Science Goal may contain one or more
sources of the same Target Type (individual pointing(s) or 1 rectangular mosaic) and is limited to one correla-
tor setup with up to five frequency tunings, one calibration strategy and one set of Control and Performance
parameters (see Section 10). You create a new Science Goal by clicking on the New Phase 1 Science Goal
icon in the toolbar or selecting Edit > New Phase 1 Science Goal from the menu bar.

Right-clicking on the Science Goal node in the Project Tree will allow you to select a number of actions to
be performed, such as renaming, copying or deleting the Science Goal. Some of the actions (e.g. copying)
are also available for nodes within a Science Goal, e.g. the Spectral Setup. It is important to understand that
Science Goals can only be pasted at the Proposal or Planned Observing node level, and parts of a Science Goal
can only be pasted at the Science Goal node level (i.e. a higher-level node must be selected and right-clicked
after copying in order to bring up the paste action). You cannot paste a Science Goal into another Science Goal.
Copy and paste of a Science Goal or parts of a Science Goal can also be achieved with the usual Ctrl-C and
Ctrl-V keyboard shortcuts or by dragging and dropping.

6 Source Information

A source can contain either one or more (overlapping) individual pointings or 1 rectangular mosaic. All pointings
defined in a given source share the velocity information and Expected Source Properties. Setting up the actual
pointings within a source is covered in Section 8. For the moment, it is sufficient to enter the source information,
especially the velocity, as this will be used for the spectral setup.

By default, the Field Setup editor contains one source tab. The first thing to select is the Target Type:



Individual Pointing(s) or 1 Rectangular field. The Target Type must be the same for all sources in a Science
Goal, and it is not possible to switch to I Rectangular field once additional sources have been added. You can
then use the Add source button at the very bottom to open additional source tabs. You will need to specify
the source information for each source individually. If your source has an entry in SIMBAD, you can
simply type its name in the Source Name field and hit Resolve to import the field centre coordinate and velocity
information from there (see Fig. 3). Otherwise, this information must be entered by hand. Solar System targets,
including the Sun, can be selected from a pull-down list if the Choose a Solar System Object box is checked.

Within a Science Goal, the OT uses a clustering algorithm to group sources within 10° into

UL separate SBs (1° for long-baseline SGs) to allow good phase calibration of all sources. Informa-
@ tion on the different source clusters can be found in the Planning and Time Estimate pop-up
) gyailable from the Control and Performance node. A source cluster can contain a maximum of

150 pointings.

Galactic coordinates are supported. The spatial visualiser will display externally loaded images in Galactic
coordinates correctly and will also convert between different coordinate systems. For example, if the source
information is defined in Galactic coordinates and the displayed image uses ICRS/J2000 (as is always the case
for the OT’s default image servers) the rectangle will be rotated to show the correct orientation in the ICRS
frame. Source coordinates read in via a text file will be interpreted as Galactic if they are given in decimal
degrees.

For each source, you are required to provide an estimate of the expected source properties. The peak flux
density entered should be an estimate of the weakest component driving the sensitivity requirement of your
Science Goal. For continuum observations only the Peak Continuum Fluz Density per Beam is required, while
for spectral line and spectral scan observations the Peak Line Flux Density per Beam and the (FWHM) Line
Width must be specified. In the latter case it may also be appropriate to enter the Peak Continuum Flux Density
per Beam if you want to observe both lines and continuum. The Line/Continuum Polarization Percentages are
required only if full-polarization observations are requested. The expected source parameters entered are used to
calculate a number of quantities in the Technical Justification editor (see Section 11) and the proposal/Science
Goal Summary Sheets. They should be used for guidance when choosing the correlator setup and sensitivity
requirements for your Science Goal.

It is your responsibility to ensure that the source information is correct. The source
coordinates and the velocity are used by the OT to calculate the pointing(s) and the sky
frequencies respectively, and can normally not be changed after a proposal has been accepted.
The expected source properties are used for the technical feasibility assessment of your proposal,
and incorrect or incomplete information may lead to the rejection of your proposal on technical
grounds. For more information on how to convert existing flux measurements for your source
to the peak flux density per synthesized beam required by the OT please see this and this
Knowledgebase article, or consult video number 2 available here.

If you have a large number of sources, you may prefer to read in the complete source information from an
ASCII file using the Load from File... button at the bottom of the Field Setup editor. As with adding sources
manually you should make sure that the correct Target Type is set before you load the source list. For the
required file format, please see the Field Setup section of the ALMA OT Reference Manual.

For solar observing you should specify the solar activity level and potentially enter a dummy ephemeris file
created using the ALMA Solar Ephemeris Generator. The ephemeris will be updated in coordination with the
observatory before any observations take place. Solar observing is currently restricted to continuum setups only.
Unlike most ALMA proposals, you do not request a sensitivity and instead enter the on-source time required
on the interferometric array. It was previously the case that solar observing with the Total Power (TP) Array
would only produce maps of the full solar disc. Since Cycle 9, however, it is possible to also obtain TP imaging of
the area of interest on the Sun’s surface, i.e., that imaged by the interferometric array. The TP regional mapping
area will be centred on the interferometric mapping position.


https://help.almascience.org/kb/articles/486
https://help.almascience.org/kb/articles/487
https://science.nrao.edu/opportunities/courses/alma-instructional-videos
http://almascience.org/documents-and-tools/cycle11/alma-ot-refmanual
http://celestialscenes.com/alma/coords/CoordTool.html

The only source property required for VLBI observing is whether the source is so faint in single continuum
(<0.35 Jy in band 1, <0.5 Jy in band 3 and 6, <0.57 Jy in Band 7), or in line observing (check the Proposer’s
Guide for the line flux limits) that passive phasing will be required. In this mode, the phasing up of the antennas
in the 12-m Array is performed on a nearby calibrator and these then retained when observing the science target.
This mode is enforced if the Phased Array is requested. If selected, it will be necessary to define a fixed phase
calibrator in the Calibration Setup. More than one science target is allowed per Science Goal, as long as the
distance in Right Ascension between all targets is smaller than 3h. The user-specified time estimate is per science
goal and needs to be at least 3h. In the VLBI Technical Justification box, the users can specify how the time
estimate should be distributed over the targets in the Science Goal.

7 The Spectral Setup

In the Spectral Setup editor, start by selecting the Spectral Type and the Polarization Products Desired as these
will influence the choices you have for defining your spectral setup. In particular, selecting Full polarization will
limit you to measurements in Bands 1, 3, 4, 5, 6 and 7. If you are not interested in polarization information you
should generally leave the radio button set to the default of Dual. XX polarization is appropriate only if you
need extremely fine spectral resolution (<30 kHz). Full polarization observations are offered for Solar observing
in Band 3 but these are limited to single continuum observations.

90-degree Walsh switching is available in Bands 9 and 10. This allows the user to access the information
not only from the spectral windows specified, but also from the resulting “image” spectral windows which lie in
the other sideband and which were being suppressed in previous cycles. Note that only the actual spectral
windows can actively be defined in the spectral line table, and that the image spectral windows will
automatically shift anytime LO1 is recomputed (e.g. if additional spectral windows are added, or the bandwidth
is changed). Walsh switching is activated by ticking the Produce image sidebands option in the Spectral Type
section. If you select this option you will be given the option to view the frequencies of the image spectral
windows with the Show image spectral windows tick-box (see Fig. 6). Walsh switching is available only when
all spectral windows in the setup use the widest (1875 MHz bandwidth) correlator mode. Note that
storing (and delivery to the PI) of the image spectral window data can be switched on or off for each spectral
window individually using the Store Image tickbox. For the Single Continuum (see Fig. 8) and Spectral Scan
spectral types with 1875-MHz-wide spectral windows, Walsh switching is automatically enabled by the OT — the
user has no choice in the matter.

The decision as to whether band-to-band (B2B) observing is required is based on a search of the calibrator
catalogue for all 12-m array configurations as well as the 7-m array.

7.1 Spectral Line

Selecting Spectral Line will present you with a spectral window table for each of four available basebands. Unless
your Science Goal requires more than 4 spectral windows, you will normally define one spectral window
per baseband. It is good practice to fill any basebands not needed for spectral line observations with continuum
spectral windows as this aids calibration, especially in the case of narrow spectral windows.

For Bands 1 and 3 to 8, for technical reasons it is not possible to place three basebands in one
of the sidebands and one in the other. This restriction does not apply to Bands 9 and 10.

You define spectral windows individually for each baseband using either the Add Spectral Window Centred
on a Spectral Line or the Add Spectral Window Manually buttons. The first option brings up the Spec-
tral Line Selector tool (see Fig. 4) which allows you to search an extensive database (The Splatalogue —
https://splatalogue.online) for popular transitions based on species, ALMA Band, sky frequency, maximum
upper-state energy or molecules detected in a variety of astronomical sources. Simply select the transition you

10
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Figure 4: The Spectral Line Selector tool.

want, press Add to spectral window list and a spectral window centred on the transition will be created upon
closing the tool. The second option Add Spectral Window Manually allows you to manually enter a spectral
window central frequency. Conversion between rest and sky frequencies is automatically performed based on the
source velocities defined in Section 6.

If you cannot find the transition you want in the Spectral Line Selector tool, try the Search
Online button: you will then be able to search online from a more extensive database. By
default, the Spectral Line Selector shows only transitions that are simultaneously observable
with any other transitions already defined in the spectral setup; untick the Hide unobservable
lines option to display all transitions corresponding to the search criteria.

Spectral windows must be associated with a correlator mode which can be selected independently for each
baseband. Double-click on the entry in the Bandwidth, Resolution column to bring up the list of available
options. The entry in bold text corresponds to the lowest spectral resolution (single-continuum) mode — TDM.
All other modes have much higher spectral resolution and are referred to as FDM. Please make sure that the
bandwidth and resolution selected for each spectral window are appropriate for the expected spectral properties
of your source(s) as entered in Section 6. 4x4-bit correlator modes can be selected on the 12-m array for dual
polarization only (exception made for the 1875 MHz-wide case, where only 2x2-bit correlator mode is available).
Such modes are marked as ‘4bit’, have the same bandwidth as the corresponding 2x2-bit modes (marked as
‘2bit’), but have double their spectral resolution. 4x4-bit modes can be selected for improved sensitivity. Please
note that only one 4x4-bit spectral window per baseband can be selected.

The spectral averaging factor is by default set to 2 in order to lower data rates. Note that an averaging
factor of 2 degrades the spectral resolution only marginally (by ~15 per cent) but halves the data rate for that

11
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Figure 5: Visualisation of spectral line observations in the Spectral Setup editor.
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spectral window. You can modify the spectral averaging factor by double-clicking on the default ‘2’ entry in the
Spec Avg. column of the spectral window table. This will bring up a list of possible spectral averaging factors.
Selecting one of the values will immediately change the spectral resolution in the table. No spectral averaging is
possible for TDM spectral windows.

The OT enforces a strict upper limit of 70 MBs~! for the data rate of the 64-input Correlator. In addition,
this is calculated using 50 antennas, the maximum that might be used during an observation. This figure refers
to the ‘peak’ data rate i.e. the instantaneous value written out by the correlator. If the limit of 70 MBs™! is
exceeded, spectral averaging should be used (or spectral windows removed) until the validation error disappears.

Based on the spectral windows defined, the OT will try to configure a spectral setup and display it in
the spectral visualiser (see Fig. 5). In order for your proposal to pass validation, all spectral windows for
all source velocities must fit within a valid sideband configuration and the same ALMA Band.
If several sources with different velocities were specified in Section 6, the OT will generate up to 5 separate
frequency tunings based on the velocities, the width of the spectral windows and spectral line width entered in
the Expected Source Properties. The number of tunings may affect the time estimate for a Science Goal and
can be checked in the Time Estimate dialogue (see Section 10).

It is possible to define up to four spectral windows per baseband, yielding a maximum total of 16 spectral
windows in a single spectral setup containing 4 basebands. Simply press Add Spectral Window Centred on
a Spectral Line or Add Spectral Window Manually to place extra spectral windows in the baseband tables.
Because only a fixed number of channels are available for each baseband they must be divided between the
spectral windows defined, implying that at a given resolution the bandwidth available for each of two spectral
windows will be half that available for a single spectral window. Therefore, the fraction of the baseband assigned
to each spectral window must be changed in such a way that the sum of all fractions does not exceed 1. The
available choices for the correlator modes in the Bandwidth, Resolution field will then be automatically updated
to reflect the lower number of channels available. Note that within a baseband all spectral windows must have
the same spectral resolution (before spectral averaging).

For VLBI line-observing in Band 1 and 3, the first baseband’s bandwidth will be fixed to 1875 MHz and only
one spectral window will be allowed. The same holds for Band 6 and 7, but these requirements are not bound
to the first baseband.

7.2 Single Continuum

Selecting the Single Continuum option is basically a shortcut to defining 4 continuum (TDM) spectral win-
dows maximising the available bandwidth (see Fig. 8). You are presented with a drop-down list of standard
continuum frequency setups for each of the available ALMA Bands, chosen so as to optimise atmospheric
transparency. The sky frequency of the setup can be changed to anything that still yields a valid spectral setup,
but any deviation from the standard frequencies must be fully justified in Section 11. An alternative option is
to enable the use of the FDM correlator mode. in the Single Continuum setup. This provides much higher spec-
tral resolution than TDM and can be useful, for example, if a continuum spectra is contaminated with narrow
spectral lines.

frame. Unlike Spectral Line mode, the velocity information entered in Section 6 is ignored in

f Single Continuum and Spectral Scan observations are specified in the “sky” (observed) reference
this case and all sources are observed with the same frequency tuning.

The spectral windows set up by the OT based on the input continuum frequency for each baseband are listed
in the spectral window tables and displayed graphically in the spectral visualiser. Note that the sky frequency
specified corresponds to the LO frequency and is not itself observed for Bands 3-8.

For Bands 9 and 10, the sky frequency corresponds to the frequency at the centre of the 8 GHz wide upper
sideband. Note that Walsh switching is always used for Single Continuum observations, yielding a
combined bandwidth of 15 GHz in Bands 9 and 10.
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Figure 7: Visualisation of spectral-scan observations in the Spectral Setup editor.

7.3 Spectral Scans

The Spectral Scan interface is a convenient way of setting up several correlator tunings to cover a wide, uninter-
rupted frequency range within a single ALMA Band. You need to specify the start and end frequency as well as
the desired Bandwidth, Resolution of each spectral window making up the scan. A maximum of 5 tunings can be
observed within one Science Goal, which means there is a trade-off between achieving a high spectral resolution
and covering a wide frequency range (if you want to cover a wider frequency range than possible with 5 tunings
you will have to split the spectral scan across multiple Science Goals). Spectral averaging is possible in the same
way as it is for Spectral Line observations. Spectral scans are available for use with the 7-m and the TP Arrays,
in either stand-alone mode or in conjunction with 12-m-Array observations.

Despite the recent increases in observing efficiency, spectral scans can still have very high time

A estimates. This will happen mostly for observations with relatively long on-source times and
many frequency tunings. It may be more efficient to set up such spectral scans using separate
Science Goals for each frequency tuning.

If the requested spectral scan can be set up successfully, the frequency tunings calculated by the OT are
displayed in the spectral visualiser (see Fig. 7) and also listed in the spectral-scan table. If not, a red error message
will appear, indicating the origin of the problem. Spectral-scan observations are offered only for Individual
Pointing(s) field setups with one pointing per source and a maximum limit of 150 pointings over all tunings (i.e.
for 5 tunings the maximum number of pointings is 30). Note that for Band-9 and -10 observations Walsh
switching is automatically turned on if the widest (1875 MHz) spectral windows are selected,
otherwise it is turned off.
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7.4 The Representative Frequency

Every spectral setup is characterised by a representative frequency, which is used to compute the spatial pa-
rameters of the Science Goal (primary beam, synthesized beamsize, maximum recoverable scale) and controls
the atmospheric transmission used in the time estimate (see Section 10). It defaults to the centre of one of
the spectral windows defined, but can be changed by the user to lie anywhere within the spectral windows of
the setup using the representative window radio button and/or typing in the relevant field below the baseband
tables. For spectral line observations, the representative frequency is a rest frequency that will be transformed
to a sky frequency using the velocity information for each source. Please check it carefully for each source,
and modify it if necessary.

The exact choice of representative frequency can severely impact the time estimate,
especially in Band 5 and the higher frequency Bands 7, 8, 9 and 10. If it falls in a
region of poor atmospheric transmission the time estimate will sky-rocket compared to a setup

A with a representative frequency in an area of good atmospheric transmission. It is important
that the representative frequency is set to the line of interest that falls into the region of the
poorest atmospheric transmission, otherwise the requested sensitivity will not be reached for
this line.

A warning will be given if the Representative Window lies in a part of the frequency spectrum where the
atmospheric transmission is less than 5%. A validation error will result if the spectral window is not represen-
tative.

7.5 Entering Rest Frequencies

You should enter the rest frequencies of any spectral lines observed with your spectral setup in the
Rest Frequencies section below the spectral line tables. These will be stored and used for data reduction and
quality assurance purposes (e.g. to provide the proper velocity scale for different image cubes, check that lines
near the edges of spectral windows are fully observed). They do not affect the spectral setup. Clicking Define
rest frequencies brings up an incarnation of the spectral line picker. Any transitions used to define spectral
windows in the spectral setup are automatically stored, but we encourage users to additionally enter
any other transitions they expect to detect with the proposed observations. Only transitions falling within the
spectral setup as defined are permitted.

7.6 The spectral visualiser

The spectral visualiser is shown by default in the Spectral Setup editor. It shows the ALMA Bands offered in
the current cycle (Bands 3 to 10) as well as the atmospheric transmission curve of the Chajnantor site. The OT
automatically chooses the water vapour column density appropriate for the observing frequency and bases the
sensitivity calculation on this. The Manual Choice is for visualisation purposes only and has no effect
on the estimated time. Once you specify at least one spectral window, a tuning is calculated and (yellow)
sidebands appear in the visualiser. The sidebands show where basebands may be placed and do not indicate the
frequency range that will be sampled by the observations. Up to four 2-GHz-wide basebands (not displayed in
the spectral visualiser) are available within each of which one or more spectral windows may be placed. Spectral
windows are defined directly by the user from within the spectral-window table and are shown in the visualiser in
blue. The LO1 frequency, sidebands and basebands are automatically calculated by the OT based
on the spectral windows defined and cannot be controlled by the user directly. If the OT cannot
compute a valid spectral setup for your spectral windows, the sidebands will turn grey and an error message will
appear.
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Figure 8: The Spectral Setup editor. Here, continuum observations have been defined.

You can zoom in/out of the spectral visualiser by left/right-clicking on the magnifying glass
symbol cursor, or by using the Zoom to Band and Reset buttons. You can move along the
frequency axis by moving the cursor near the axis and dragging the green sliding bars or using
Pan to Line. For a practical demonstration of the spectral editor please watch the spectral
setup video tutorial.

8 Finalising the Spatial Setup

Having specified the spectral setup and in particular the representative frequency, you are now ready to finalise
the spatial setup based on the sources you defined in Section 6. The maximum total number of pointings in the
largest array (12-m or 7-m for Standalone ACA) is 150, regardless of whether these are treated as mosaics, offset
pointings or separate sources.

8.1 Individual Pointing(s)

You can visualise and configure the spatial setup for each source individually by selecting the relevant source
tab. By default, there will be just one pointing at the source coordinates specified earlier. Offset pointings can
be added, edited and deleted directly in the Field Center Coordinates panel or interactively in the Spatial Visual
Editor (see boxed text). The Import button will read offset pointings for a given source from an ASCII file in
simple RA, DEC format. You can also Ezport pointings, e.g. to be used for simulations, in different coordinate
formats.

Non-overlapping offset pointings are no longer allowed within one field source. Instead, all pointings within
one field source must overlap and will be processed as one image.

If ACA 7-m observations are requested (Section 10) these will have the same pointing centres as the 12-m
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pointings defined; any custom-defined mosaic will not be adjusted for the larger primary beam size of the 7-m
antennas. Also, the sensitivity specified in Section 10 is assumed to be per pointing and the estimate entered
should take into account any overlap.

8.2 1 Rectangular Field

ip By default, the spatial editor shows only the rectangular area defined for the mosaic. To see the

= & individual pointings set up by the OT, you need to press the Show pointing positions button in
=22/ the toolbar above the spatial editor.

The Rectangular Field option is a convenient way to easily set up evenly sampled rectangular mosaics on a
per-source basis. You simply specify the size of the field as p length times q length, the Position Angle and the
Spacing of individual pointings. By default, the spacing is set to Nyquist sampling (Spacing = 0.51 times fraction
of antenna beamsize). If you change this, you must carefully justify your choice in the Technical Justification
(Section 11). For rectangular fields, the 7-m Array pointings are automatically set up to optimally sample the
area specified, therefore the number of pointings will be smaller than for the 12-m Array. You may wish to
export the coordinates of the individual pointings; this is done using the Ezxport button next to the displayed
number of pointings.

Mosaics are allowed also in full-polarization mode. These can be defined in the usual way as either a collection
of individual pointings or as a rectangular box that is automatically tiled by the OT. Nyquist sampling is highly
recommended and for rectangular boxes the OT will warn if the pointings are sampled at less than the Nyquist
frequency. If a polarization mosaic is requested, the spectral setup will be forced to a Single Continuum setup at
the standard continuum frequencies for the selected band. In case high spectral resolution is required in order
to remove spectral lines, the Single Continuum mode now contains the option to select FDM.

8.3 The spatial visualiser

The spatial visualiser (see Figs 9 and 10) is found under the Spatial tab of the Field Setup editor. It can be
used to view and edit pointings on a per-source basis and will work properly only if you load an image.
Either Query one of the image servers selected from the drop-down menu to display a catalogue image of the
area surrounding your source, or load and display your own FITS image by clicking the folder icon in the spatial
editor toolbar. The primary beams of the pointings defined are represented by red circles, and can be moved,
added and deleted interactively. They can be displayed for either the 12- or 7-m antennas if ACA observations
have been requested. If Total Power observations are requested, the area scanned is shown by a turquoise
box. For individual pointings, this box dynamically adapts to cover the pointings defined. You can use the
buttons in the toolbar above and below the spatial visualiser to perform simple visualisation operations such as
adjusting the cut levels, zooming, and saving the image. Please see the spatial setup video tutorial for a practical
demonstration of all functionalities.

The sensitivity in a single pointing is not uniform, but gradually falls off away from the pointing
centre. For rectangular mosaics, the fall-off in sensitivity is automatically taken into account by

A the fact that the individual pointings are set up so as to overlap. The FHWM of the antenna
beam is represented by a red circle in the spatial visualiser and a smaller green circle (1/3 of
the FHWM) is shown to emphasize the inner area where the sensetivity is highest.

17


http://almascience.org/proposing/observing-tool/video-tutorials

File
8 24aa
Project Structure
Proposal

Ede Mww Tool Search Help

¥ i Cycle 5 Quickstart Guide
+ I Proposal
# (=] Planned Observing
¥ U ScienceGoal (Science Goall

2
Calibration Setup

[} contral and Performance
[ Technical Justification

Open image
from fits file

O e s
N

Add single
pointing

Pointings:

primary beam
(red) and imaged
area (green)

202, 455 21956.0
22:29.45.201, ~20.47.29.44 (2000)
age Fllename I/ jsky3 fcache jsky3169991011233304157 fits

Fov Parameters

7=
Representative Frequency (Sky) 90.776 GHz
Antenna Diameter ® 12m
Antenna Beamsize (HPEW)  64.146 arcsec
Show Antenna Beamsize ¥
Image Query
7=
Image Sarver Digitized Sky (Version W at ESO -

Image Size{arcmir 10.0

3 Query

Query image server

Figure 9:

File Edit Vew TIool Search Help
a8 e84
Project Structure

Proposal

% i Cycle § Quickstart Guide
% [ Proposal
? [ Planned Observing
i) ScienceGoal (Science Goal)

) Conrsl and Performance
[} Technical justificasion

Source tab
Cloned source

Copy of Helox pebula

Perspective 1

Source Name Helix nebula Resolve
Choose a Solar System Object? Name of object Unspecified
system /KRS = :d'*" Parallax 4.56000 mas | ¥
Source Coardinates o TR PMAA 32.00000 mas/ye |
Dec  -20:50:13.640 PM DEC |-5.00000 mas/y |+
Source Radial Velocity -15.000 kmjs|w | |hel |w| 2 -0.000050033 Doppler Type |RELATIVISTIC | »
Target Type
Expected Source Properties
7=
Peak Continuum Fhux Density per Synthesized Beam 0.1 Iy |*
Continuum Polarization Percentage 0.0 per cent
Peak Line Flux Density per Synthesized Beam 0.5 Ir =
Line Width 20.0 km/s| ¥ Add d &
Line Polarizati 0.0 per cent ! € It

Field Center Coordinates

Coord Type ® Relative
Offset Unit | arcsec
#Pointings 3

RA [arcsec]

add

Add Source Load from File...

Export to File.

delete offset
pointings

Import

Export

Clane Source Delete Source Delete All Sources

Visualisation of individual pointings in the spatial tab of the Field Setup editor.

[ I TN~ I N ]
:(ﬂm
Spal

Show pointing positions

Spatial Image

alBl®

"X®0¥lﬁ

Mosaic pointings

Toggle
display

pointings

@ [a] &5

12:22:55.224, +15:51:46.32 (2000}

293, 443 6200.0

FOV Parameters

i
e Frequency (Sky) 90.297 GHz i

im

to Antenna Beamsize (HPEW) 6 farcsec

Show Amtenna Beamsize
7-m s oy

7
Digitized Sky (Version I) at ESO -

Size(arcmin) 10.0 Query

Image Filename I/ jsky3 /cache [jsky22 79934677 759154235, fits

Perspective 1

M100
Source
Source Name ML00 Resolve
Choose a Solar System Object? Name of objeet Unspecified
Parall -
System IR - arallax 0.00000 mas
Source Coordinates A Tor Eoata 086 PMRA  0.00000 masiyr |
Dec | 15:49:20,570 PM DEC 0.00000 mastyr |
Source Radial Velocity 1569.779 km/s|w| et | v z 0.005250000| Doppler Type RELATWISTIC |+
Target Type indvidual Posnting
Expecied Source Proparties
Peak Continuum Flux Density per Synthesized Beam 0.10000 w |»
Continuum Polarization Percentage 0.0 per cent
Peak Line Flux Density per Synthesized Beam 0.50000 w |-
Line Width 20.00000 km/s | w
Line Polarization Percentage 0.0 per cent
Rectangie
7)/=)
Coords Type ® Relative © Absolute
System ICRS -
Field Center
Coordinates OffsetiLongitude) 5.06405 arcsec |»
OffsetiLat ) | -0.99463 arcsec | v
p length 199.23965 | arcsec |w Deﬁne
qlengh  158.87674 | [arcsec |+ I
Position Angle 45.21460 deg | g

Spacing 0.51093

#Pointings  12m Array 39

Add Source Load from File..

Export to File.

field
parameters

fraction of antenna beamsize | Re
7m Array 14

Chone Source

Figure 10: Visualisation of a rectangular mosaic.

18



9 Calibration Strategy

You should normally use the default System-defined calibration option in the Calibration Setup editor. The
system-defined calibration is designed to fully calibrate your science observations using the most appropriate
sources available at execution time, and will at least include pointing, bandpass/flux and phase calibration.
Science Goals requiring full polarization will receive an appropriate calibration strategy. Only experts whose
projects have special calibration requirements should specify User-defined calibration.

An extra option is available for the system-defined calibration strategy: force separate amplitude calibration
using solar system object. By default, the OT assumes that it is acceptable to use the same quasar from a
regularly monitored sample for both amplitude and bandpass calibration. However, if you have any special
amplitude calibration requirements you can force an extra observation of a Solar System object for
amplitude calibration if such an object is available at the time of SB execution. This will add a few
minutes to your time estimate (see Section 10).

If passive phasing has been selected, you will need to define a fixed (specific) phase calibrator instead of
a query. The user-defined calibration interface should have been selected automatically and the existing phase
query should be deleted. Then choose Add Fized Calibrator and select a specific source from the ALMA calibrator
catalogue. Calibrators need to have a flux in the band of interest >0.5 Jy and ideally be within 5° of the science
target. The choice of calibrator should be described in the Technical Justification.

10 Control and Performance

The final technical specifications of your Science Goal are entered in the Control and Performance editor (see
Fig. 11). The Configuration Information section at the top of the page displays information on the array
configurations available in the current cycle, and uses the representative frequency defined in the spectral setup
to calculate the Synthesized beamsize and the Maximum Recoverable Scale of the observations.

The Desired Angular Resolution (AR) and the Largest Angular Structure (LAS) are used together to deter-
mine the array configuration(s) the observations can be executed in. PIs cannot explicitly request specific
configurations, but should instead make sure that the AR and LAS parameters entered are correct. The array
configurations selected for your observations will together have baselines long enough to match the AR requested,
and be compact enough to resolve the LAS. Often this will mean that a number of configurations are acceptable
for a given Science Goal or that up to two 12-m configurations as well as ACA 7-m and TP observations are
included (for limitations and possible array combinations see Section A.4 of the Proposer’s Guide). Details on
the configuration setup devised by the OT can be found in the Planning and Time Estimate pop-up.

From Cycle 11, the OT considers the full range of 43- to 50-antenna configurations and beam-
elongation at non-transit executions in oder to calculate the time estimates and image char-

A acteristics based on these configurations. The user entered values for angular resolution are
increased by +/- 20% to increase the chance of configuration matching. Due to holes in an-
gular resolution coverage between configurations, it is possible that the OT cannot assign a
configuration and will issue a validation error.

Users do not directly select whether ACA 7-m and /or Total Power observations should be added

N7 to their 12-m observations or not. Instead, the ACA is imposed by the OT if required to achieve

L@ the LAS requested. Whether or not ACA observations will be scheduled can be easily seen in

wewen) the Planning and Time Estimate pop-up (see Fig. 11) or the Proposal Time Summary dialogue
(“clock” icon on the menu bar).
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Users of the 12-m array have the option of entering a single value (as in previous cycles), a range of acceptable
AR values, or asking for observations with any AR. If a range of AR values is entered, the OT will assign one
or more configurations that match the AR anywhere in the specified range. This gives more flexibility for
scheduling observations where the AR requirement is only loosely constrained. Note that if an
AR range is given and the sensitivity requirement is entered as a brightness temperature, the OT assumes the
most extended configuration when computing the time estimate as this requires the most time. The equivalent
brightness temperature achieved for the more compact end of the AR range is indicated for information only.
The Any button (see Fig. 12) in practice limits the AR to the values given in the Configuration Information for
the most compact and most extended 12-m configuration, excluding long-baseline configurations (since these are
less efficient to calibrate). For this option users must enter the requested sensitivity in Jy.

It is not the case that every configuration will be visited during a cycle. For example, the two largest
configurations (C-9 and C-10) will not be visited in Cycle 12. The OT will be configured to know which
configurations are available and will adjust the achievable angular resolutions accordingly.

ACA stand-alone observations are requested explicitly by selecting Standalone ACA as the option for the
Desired Angular Resolution. If necessary to achieve the LAS requested, Total Power observations will be added
only for spectral line observations in Bands 3-8. Note that for stand-alone observations the ACA 7-m time
estimate is specifically computed for the sensitivity requested, rather than being a multiple of the 12-m Array
time. Given the greatly reduced total collecting area of the 10 7-m antennas compared to the 12-m array, a
stand-alone ACA proposal will require significantly more ACA time for the same sensitivity request.

You can define and check technical details of the observations using the following fields (fields displayed in
red must be filled):

e Desired Angular Resolution: your choice is guided by the synthesized beamsizes corresponding to
the most compact and most extended configurations available in the current cycle as displayed in the
Configuration Information. The value(s) entered cannot be smaller than the synthesized beam size of the
most extended configuration and cannot be larger than the synthesized beam size of the most compact
configuration.

e Largest Angular Structure in source: here you should enter the largest angular structure that you
wish to image in your source(s), which may be different from the actual size of the source. The value
entered determines whether you need multiple 12-m configurations and/or the ACA, and therefore has a
direct influence on the time estimate (see the Mazimum recoverable scale for the 12-m configurations in the
Configuration Information table for guidance). The input units are the same as for the angular resolution.
It is not used if an angular resolution of Any is selected.

e Desired Sensitivity per Pointing: you should enter the 1-0 rms sensitivity required for the most
restrictive line/continuum observation to achieve the scientific aims of the Science Goal, and if relevant
mention the S/N achieved for the remaining lines/continuum in the Technical Justification. In the case of a
rectangular field mosaic you should specify the sensitivity required over the mosaic, not that for individual
overlapping pointings. We recommend that the sensitivity requested is good enough to give a 3 ¢ detection
at the very least, ideally 5 o.

e Bandwidth used for Sensitivity: for continuum observations, this field is automatically set to Aggre-
gateBandwidth. For spectral line or spectral scan observations you can pick one of six choices given in the
dropdown menu:

- RepWindowEffectiveChannel Width: the narrowest effective channel width (including Hanning smooth-
ing and spectral averaging) of the spectral window chosen as the sensitivity driver for the observations
(and containing the Representative Frequency) in Section 7.

- Representative WindowResolution: the (Hanning-smoothed) spectral resolution of the representative
spectral window, taking into account spectral averaging. This is the default for spectral-line setups.

- Aggregrate Bandwidth: the summed, non-overlapping bandwidth of all your selected spectral windows.
This is the default for single continuum.

- LargestWindowBandwidth: the bandwidth of your widest spectral window defined.
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Figure 13: The time constraints interface and Time Estimate box for the example of Multiple Visits and Simul-
taneous 12-m and 7-m observations.

- FinestEffectiveChannelWidth: the smallest effective channel width of any of the defined spectral
windows.

- User: a bandwidth of your choice (useful if you are intending to smooth your data after observation
to achieve a certain S/N).

Observations requesting very small angular resolutions (i.e. those making use of long baselines)
are inefficient because they need to be frequently calibrated to correct for atmospheric phase
fluctuations. Since the array configuration is determined based on the AR defined in the OT,
it is possible to inadvertently trigger long baseline observations by entering an AR just slightly
smaller than that actually required. You can see if the observations defined make use of long
baselines in the Planning and Time Estimate pop-up — the first 12-m configuration will be
labelled C-7 to C-10 and the number of phase calibrator observations per SB execution will
be larger than usual. Long baselines should be avoided if they are not necessary to achieve a

Science Goal.

Please pay close attention that the Bandwidth used for sensitivity is appropriate for your scien-
tific aims. For spectral line observations we recommend that it is at most 1/3 of the expected
spectral line width. Selecting too wide a bandwidth will lower the time estimate but yield too

low a sensitivity.

The Planning and Time Estimate button will estimate the total time required to achieve the desired sensitivity
goal on the largest array, either the 12- or 7-m, including calibration (pointing, bandpass and phase, as well
as flux calibration if requested and reference positions for TP observations) and overheads (telescope slewing,
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computational latencies). The time for the smaller configurations is estimated using multiples of the time required
for the largest array. The multipliers are based on simulations — see the Technical Handbook for more details.

Additional options that affect the time required are:

e Override OT’s Sensitivity-Based Time Estimate: If your Science Goal is not sensitivity driven, but
instead requires a certain time (e.g. for a monitoring experiment) you can choose to override the OT’s time
estimate. The time entered should be the total time (including calibrations and overheads) for the more
extended 12-m configuration needed; time estimates for the ACA are the automatically calculated by the
OT.

e Are the Observations Time-Constrained?: The OT has the ability to capture the following time
constraints:

- Single Visit: specify fixed time intervals during which your observations should be executed. The
observations will be carried out only once in total, within any of the time windows specified. You
can manually Add time windows individually or Import a list of time slots from an ASCII file. See
the Control & Performance section of the ALMA OT Reference Manual for the format required.

- Multiple Visits: define multiple visits for your Science Goal. The timing constraints of the individual
visits are specified in terms of arbitrary, fixed or relative time intervals. Here, the observations will be
carried out once for each visit specified. The time estimate computed by the OT will be multiplied
by the number of visits (see Fig. 13).

e Simultaneous 12-m and ACA observations: If this is selected, it is assumed that the observations
will be observed at the same time. The total time required for the largest array configuration will also be
assigned to the smaller arrays. Note that configurations C-7, C-8, C-9, and C-10 are however excluded from
simultaneous observing, as they cannot be paired with ACA. A warning will be triggered by the OT if the
requested angular resolution and maximum recoverable scale combination requires two 12-m configurations
and the more compact configuration is being dropped because the simultaneous observation option has
been chosen.

Selecting Tool in the OT menu gives you access to a number of useful tools to help you better

plan your observations. You can use the Sensitivity Calculator to bring up a pop-up window

= ' \- that allows you to experiment with project execution times and sensitivities, the Project Time

Summary (“clock” icon) to give a time and data-rate summary, and generate printable and

N PDF summaries of individual Science Goals as well as the whole proposal (including a cover
sheet).

11 Technical Justification

For the majority of proposals, the technical justification is entered in three sections: Sensitivity, Imaging, and
Correlator configuration. Relevant parameters are taken or computed from the Science Goal setup and the
Expected Source Properties are displayed for each section. If the OT detects values it thinks should be double-
checked, an informative message is displayed in blue. You should pay special attention to these issues in your
justification text. Note that any supporting figures (e.g. simulations) should be included in the science case PDF.

You must enter a short justification text in the free-format text boxes of each section. In addition, text
boxes will appear for any choices that need to be justified. These include using single polarization, non-standard
continuum frequencies, non-Nyquist spatial sampling, a user-defined calibration strategy, overriding of the OT’s
suggestion of the ACA or time estimate, low maximum elevation of a source and time-constrained observations.
For detailed guidelines on filling the Technical Justification please see the Proposer’s Guide and the technical
justification video tutorial.
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Figure 14: The technical justification editor.

12 Validating and Submitting

A proposal must pass validation before it can be submitted. This is most easily checked by clicking on the “tick”
icon in the toolbar which will cause any errors or warnings to be shown in the Feedback pane (see Fig. 15).
Warnings are for your attention and should be double-checked, but they do not prevent you from submitting a
technically sound proposal. Double-clicking on an error/warning message will take you to the relevant Science
Goal so that you can easily identify and correct the problem. With all errors corrected, your project is now ready
to be submitted.

To submit your project to the ALMA archive select File > Submit Project in the menu bar. You and all
of your Co-Is should receive a confirmation email after each proposal submission. Once you have submitted,
the Unsubmitted Proposal label in the blue proposal status bar will be replaced by a red Submitted label. This
indicates that the proposal has been stored in the ALMA archive and assigned the Project Code listed in the
titlebar of the OT GUI. You are encouraged to save your project to disk after submission in order to ensure that
any updates are made on the submitted version.

Once a proposal has been submitted and a proposal code assigned, its proposal type cannot be

A changed anymore (the options are greyed out). If you need to change the proposal type, please
open the project as a new proposal in the OT and retract the submitted proposal via a ticket
to the ALMA helpdesk.

You can make changes and re-submit your Submitted proposal until the deadline; any re-submission will
overwrite the previous version of the proposal stored in the archive. For more detailed information on the
ALMA OT and the technical capabilities in the current cycle you are invited to consult the documentation
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Figure 15: An example of failed validation.

available on the Science Portal. If you have any questions or comments please feel free to submit a ticket to the
ALMA Helpdesk.
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The Atacama Large Millimeter/submillimeter Array (ALMA), an international astronomy
facility, is a partnership of the European Organisation for Astronomical Research in the
Southern Hemisphere (ESO), the U.S. National Science Foundation (NSF) and the National
Institutes of Natural Sciences (NINS) of Japan in cooperation with the Republic of Chile.
ALMA is funded by ESO on behalf of its Member States, by NSF in cooperation with the
National Research Council of Canada (NRC) and the National Science and Technology
Council (NSTC) in Taiwan and by NINS in cooperation with the Academia Sinica (AS) in
Taiwan and the Korea Astronomy and Space Science Institute (KASI).

ALMA construction and operations are led by ESO on behalf of its Member States; by the
National Radio Astronomy Observatory (NRAQ), managed by Associated Universities,
Inc. (AUI), on behalf of North America; and by the National Astronomical Observatory of
Japan (NAQJ) on behalf of East Asia. The Joint ALMA Observatory (JAO) provides the
unified leadership and management of the construction, commissioning and operation of
ALMA.

National Astronomical
Observatory of Japan
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